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sistema funcional para generación de puntaje semi-automático para diferenciación condrogénica. Corroboramos estos resultados 
mediante análisis bioquímico con resultados comparables. En nuestro saber este es el primer reporte en evaluar esta metodología, 
la cual puede ser útil para otras aplicaciones en el campo biológico o médico.   

Palabras clave: células mesenquimales, condrogénesis in vitro, glicosaminoglicanos, ImageJ.

Resumo

Estabelecimento de um sistema de pontuação semi-automático para ensaios histoquímicos e imuno-histoquímicos para avaliar 
diferenciação condrogênica in vitro. Durante o desenvolvimento embrionário os membros emergem a partir da condensação de 
células mesenquimais e sua diferenciação em condrócitos em um processo chamado condrogênese. Estes condrócitos sintetizam 
glicosaminoglicanos, desempenhando um papel importante neste processo. Existe um sistema de condrogénese in vitro utilizando 
células mesenquimatosas, geralmente avaliado por histoquímica. Objetivo. Estabelecer um sistema de pontuação semi-automático 
para ensaios histoquímicos e imuno-histoquímicos. Materiais e métodos. Na condrogênese as células foram cultivadas com 
meio indutor em agregados, durante três semanas. Os glicosaminoglicanos totais foram determinados pelo azul de dimetileno. 
Para a análise histológica os agregados foram corados com Azul Alciano e imuno-histoquímica para detecção de agrecan.  A 
pontuação semi-automática foi obtida utilizando o programa ImageJ. Resultados. As células mesenquimais cultivadas em meio 
de diferenciação condrogênica tiveram uma concentração de proteína comparável durante as três semanas de cultura, o que sugere 
uma celularidade similar. A concentração de glicosaminoglicanos foi maior para os agregados cultivados em meio condrogênico. 
A mesma tendência foi observada para a coloração com Azul Alciano segundo as pontuações do observador cego e a análise 
com ImageJ. Finalmente, os resultados de imuno-histoquímica de pontuações dados pelo observador e aqueles dados pela análise 
ImageJ revelaram uma tendência decrescente ao longo do tempo para os agregados em meio condrogênico. Conclusão. Nós 
realizamos um sistema funcional para gerar pontuação semi-automática para diferenciação condrogênica. Nós corroboramos esses 
resultados por análise bioquímica com resultados comparáveis. Segundo nosso conhecimento, este é o primeiro estudo a avaliar 
esta metodologia, que pode ser útil para outras aplicações no campo biológico ou médico.

Palavras-chave: células mesenquimais, condrogênese in vitro, glicosaminoglicanos, ImageJ.

Introduction
Chondrogenesis, the first step in endochondral bone 
formation, is a process where the skeleton is ensued from 
a cartilage mould or anlagen (1, 2). It begins with the 
recruitment of mesenchymal cells aggregating at the site 
where future skeletal elements will be formed. Following 
migration, epithelial-mesenchymal interactions result in 
condensation (3). Most bones are formed by this process 
where mesenchymal cells condense and differentiate 
into chondrocytes to form a cartilage mould (2). During 
differentiation mesenchymal cells become chondrocytes 
and secrete an extracellular matrix (ECM) rich in aggrecan, 
a type of proteoglycan composed of a core protein and 
glycosaminoglycans (GAGs), and collagen type 2 (4). 
After the cartilage mould has been formed, chondrocytes 
in the center stop proliferating, enlarge and hypertrophy. 
These modifications are regulated by changes in gene 
expression, with collagen 10 becoming the principal 
ECM protein. These hypertrophic chondrocytes direct 
mineralization of their enveloping matrix and attract 
blood vessels. Last, hypertrophic chondrocytes undergo 
apoptosis to provide the necessary scaffold for true 
bone matrix deposition with osteoblast and blood vessel 
invasion (4). These series of highly orchestrated events 
are characterized by different cellular processes and 
separate genetic controls (3).

Since chondrogenesis in the embryo is such a complex 
process for over a decade a simplified system, in vitro 
chondrogenesis, has been used for studying cellular 
differentiation using mesenchymal stromal cells (MSCs) 
(5). Mesenchymal stromal cells are multipotent progenitors 
of connective tissue (6). These cells have the potential to 
differentiate in vivo or in vitro into mesodermic lineages: 
adipo-, osteo-, and chondrogenic (7). In addition to their 
differentiation potential in order to define a MSC two 
other criteria must be met: MSCs should adhere to plastic 
and have specific surface antigen expression (8).

Isolated MSCs from human bone marrow cultured in 
aggregates with defined media containing TGF-β appear to 
promote initial cell density and signaling pathways needed 
to induce chondrogenic differentiation (9). Furthermore, 
in vitro chondrogenesis has been demonstrated with 
MSCs isolated from adipose tissue (10-12). Studies in 
MSCs isolated from adipose tissue have evidenced lower 
chondrogenic efficiency. However, addition of BMP-6 
has been demonstrated to improve chondrogenic potential 
(13). After the previously mentioned conditions MSCs 
should undergo chondrogenic differentiation within 
the following weeks with a characteristic extracellular 
matrix composed of aggrecan and collagen type 2 (14). 
Expression of these markers has been used to evidence 
differentiation.  
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In vitro chondrogenic properties have been assessed by 
biochemical analysis and histological staining (15). Most 
reports have evaluated total sulfated GAGs accumulated in 
the ECM of aggregates. To this end some have modified a 
Safranin-O dye binding assay or dimethylmethylene blue 
method (16). Chondrogenesis induction of adipose derived 
MSCs has been confirmed by the presence of sulfated 
proteoglycans within the matrix by Alcian blue stain, and 
specific determination of GAGs by immunohistochemistry 
(IHC) marker assessment (17). 

Using staining to demonstrate in vitro differentiation into 
chondrogenic lineage has been an accepted methodology, 
since it provides evidence for the presence of GAGs during the 
chondrogenic process (8). Furthermore, IHC for chondrogenic 
markers specifically determines the molecule synthesized. 
Many reports mention that histological assessment was 
associated with a positive stain in the ECM (10). Others, 
report a grade based on values given by a blinded observer. 
It is known that a visual grading system might present an 
overestimation by the observer. Considering histological 
analysis is a critical tool to determine in vitro chondrogenesis 
an objective and quantifiable technique is needed to assess 
a histological result. 

Techniques for quantifying histological stains or IHC 
markers have been attempted by a number of authors using 
chromophores and color deconvolution (18, 19).  We were 
able to perform an objective and accurate assessment of 
histochemical stains using color segmentation and IHC 
marker determination by evaluating hue, saturation and 
brightness. Hence, in this report we describe how a 
public domain, Java-based image processing program 
developed by the National Institutes of Health ImageJ 
(20), can be used as a semi-automatic grading system for 
both histochemical stains and IHC marker determination 
obtained from sections in aggregate cultures during in 
vitro chondrogenesis.

Materials and methods

Mesenchymal  stromal cell isolation and 
culture expansion

Adipose tissue was collected after informed signed consent 
from females (n = 3 ages:  24 to 38) undergoing cosmetic 
surgery with the approval of the Bioethics Committee 
at the Pontificia Universidad Javeriana. Adipose tissue 
MSCs were isolated as previously described with slight 
modifications (10). Briefly, samples were washed, digested 

with collagenase (Invitrogen Carlsbad, CA USA) and the 
stromal vascular fraction (SVF) containing MSCs was 
resuspended in α-MEM (Gibco, Carlsbad, CA) supplemented 
with 10% fetal bovine serum (FBS, Eurobio, CEDEX B 
France), and 100 U/ml penicillin, 100 µg/ml streptomycin 
and 0.25 µg/ml B: amphothericin B (Lonza, Walkerville, 
MD), hereafter complete media or CM. Cells were seeded 
and tissue culture plates were incubated at 37 oC with 5% 
CO2 and humidified atmosphere. Media was changed 24 
h after plating.

Mesenchymal stromal cell characterization  

Plastic adherence and Immunophenotypification

Adipose derived cells below passage seven were cultured 
in complete media to evaluate adherence to plastic. 
Immunophenotypification was determined by MSCs 
incubation with allophycocyanin (APC), fluorescein 
isothiocyanate (FITC) and phycoerythrin (PE) conjugated 
monoclonal antibodies against human CD34 (Dako, Eching 
Germany), human CD73 (eBioscience, San Diego, CA, USA), 
human CD90 (FITC Dako, Eching Germany) and human 
CD105 (PE, eBiosciences). Background fluorescence was 
established by MSCs incubation with antibodies against IgG1 
(APC and FITC, Dako) and IgG1K for PE (eBioscience). 
Flow cytometry was performed on a FACSAria (Becton 
Dickson, San Jose, CA) and results were analyzed using 
FlowJo software (Tree Star, Ashland OR).

Multilineage differentiation

Cells at passage one were trypsinized and 96 x 103 cells 
were seeded in six well plates and incubated with complete 
media for 24 h. Adipogenesis and osteogenesis was 
evaluated culturing cells with media supplemented with 
inducers according to Zuk et al. (17) with modifications. For 
adipogenesis we used half the concentration of indomethacin 
and a 5.8 fold decrease in insulin concentration, and for 
osteogenesis a fourfold increase in ascorbic acid.

Chondrogenic differentiation

For chondrogenesis an aggregate culture system was used. 
Briefly, approximately 250 x 103 cells passage two in CM 
were placed in a polypropylene tube and centrifuged at 300 
x g for five minutes to form a pellet. Twenty-four hours after 
centrifugation induction was initiated. The cells were cultured 
in either complete media or chondrogenic differentiation 
media (Lonza, Walkerville, MD USA) supplemented with 
BMP-6 (Sigma-Aldrich, St. Louis MO USA) and TGF-β3 
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(Invitrogen) at 10 ng/ml respectively. Media was changed 
twice a week for 21 days. 

Biochemical analyses

Total protein was quantified using BCA assay (Pierce,Thermo 
Scientific Rockford, IL USA) according to the manufacturer’s 
instructions from aggregate lysate in 0.9% NaCl 
solution. Total sulfated GAGs (sGAGs) were assayed by 
spectrophotometric procedure with 1,9-dimethylmethylene 
blue (Sigma-Aldrich). Total GAG determination by DMB 
(mg/ml) was normalized to total protein (mg/ml).

Histologic and immunohistochemical 
analysis

For microscopy analysis, spheres were fixed in 4% 
formaldehyde and embedded in paraffin. For total GAG 
detection 4 µm sections were stained with Alcian blue. 
Aggrecan expression in aggregates was examined by IHC 
using Leica Biosystem automated BOND (Leica Biosystems, 
Buffalo Grove, IL). Briefly, epitope was retrieved for 20 
minutes at pH 8.8, followed by primary antibody incubation 
against aggrecan (Santa Cruz Biotechnology, Santa Cruz, 
CA) for 15 minutes. Immunolabeling was detected using 
a Bond Polymer Detection kit (Leica Biosystems) with 
horseradish peroxidase conjugate and diaminobenzidine 
(DAB) as substrate. 

ImageJ analysis 

Tagged image file format (TIFF) Images were captured 
by Nikon E600 microscope at 20X magnification 
(Nikon Corporation, Melville NY, USA), and composite 
images (magnification) by the robotics microscope at the 
BioIngenium facility at Universidad Nacional de Colombia 
at 40X. For robotics microscopy image sections were 
captured and assembled using an algorithm developed by 
this facility. Histological assessment of Alcian blue stain 
and IHC marker for aggrecan were performed. For Alcian 
blue stain the TIFF image was opened with ImageJ (Figure 
1 A). Then the image was Adjusted to Color Threshold 
from hue, saturation and brightness (HSB) to red, green, 
and blue (RGB) color space (Figure 1 B black arrow 1). 
In addition, Threshold color was selected on Red (Figure 
1 B black arrow 2). The color threshold was adjusted for 
each image to depict the areas that display the positive 
areas of Alcian blue by defining minimum and maximum 
values for each color (Figure 1 B purple arrows). The 
mask created by the threshold color was then changed from 
Red to black and white (B&W) (Figure 1 C). The Image 
was changed to grayscale by setting Image Type to 8-bit. 

After converting the image to grayscale the Image was 
Adjusted to Threshold into B&W (Figure 1 D). To define 
entire aggregate section area Freehand selections delineated 
the total area (Figure 1 E). To eliminate pixels outside of 
selected area Edit Clear Outside was chosen (Figure 1 
F). To calculate total aggregate section area Analyze was 
utilized and Measure was chosen (Figure 1 F). The value 
for total section area was recorded. To determine the area 
of positive Alcian blue stain Analyze followed by Analyze 
Particles was defined. The value obtained was recorded 
(Figure 1 G). To calculate the area of positive Alcian blue 
stain the Analyze particle value was divided by the value 
recorded for total aggregate section area. The value obtained 
was defined in percentage by multiplying this last result 
by 100 (Figure 1 H). For IHC percentage determination 
the same procedure aforementioned was utilized with the 
exception that instead of color segmentation by threshold 
(RGB) Image was Adjusted to Color Threshold set in hue, 
saturation, and brightness (HSB). Since ImageJ assessment 
for both histochemical Alcian blue stain and aggrecan’s IHC 
is a semi-automatic grading system, false positives are not 
included in the analysis because the person performing the 
evaluation can omit these areas. To calculate Percentage 
improvement the following equations were calculated.

      (1)

Where sem is standard error mean for the parameter measured, 
and mean is the average of the parameter measured. Sem 
percentage was calculated for each complete or chondrogenic 
differentiation media for both blinded observer (BO) or 
ImageJ (IJ) analysis.

       

 Where IJ refers to ImageJ standard error mean (sem) 
percentage as determined in equation (1) and BO refers 
to blinded observer sem percentage as determined in 
equation (1). 

   

Where IJ vs. BO difference were determined in equation (2).

Statistical analysis

Results are presented as mean ± standard error mean 
(n = 3 with replicas for each sample). To determine levels 
of significance results were analyzed using One Way 
ANOVA followed by Tukey post hoc test. Differences 
were considered significant at p < 0.05. Graph Pad Prism 
Version 3.1 (Graph Pad Software, San Diego Ca, USA) 
was used for statistical analysis. 

sem
mean

× 100 = sem percentage

IJ sem percentage
BO sem percentage = IJ vs. BO difference (2)

1 - IJ vs. BO difference × 100 percentage improvement (3)
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Figure 1. Schematic representation of methodology used for ImageJ analysis. (A) Open Alcian blue image by selecting 
File → Open Samples → PLA05 CDM W2. (B) Adjustment to Red Green and Blue: Image → Adjust → Color Threshold. In 
window Color space to RGB (arrow 1) and Color Threshold to Red (arrow 2) were adjusted. Threshold values for each color 
(purple arrows) were defined. (C) Color Threshold from Red to B&W (arrow) was changed. Threshold Color window was 
closed. (D) Color image was converted to grayscale: Image → Type → 8-bit. Image → Adjust → Threshold → BW → apply. 
Analyze → Set scale.  Values were selected as depicted.  OK was selected. (F) To eliminate background noise Edit → Clear 
outside was elected. To measure pixel number in selected area Analyze → Measure was chosen. (G) Positive Alcian blue area 
was determined by Analyze → Analyze particle. Value was recorded. (H) Percentage positive area was calculated by dividing: 
325650/1650156 = 0.1973. This obtained value was multiplied by 100 to obtain percentage 0.1973 x 100 = 19.73. Positive 
Alcian blue stain was 19.73%.   
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Results
Adipose tissue derived cells were adherent to plastic and 
met all the characteristics as previously described in the 
literature for MSCs (8). They were positive for CD73, CD90, 
and CD105 and less than 2% of the population assayed was 
positive for CD34 (Figure 2 A and B). Cells differentiated 
into adipogenic, osteogenic and chondrogenic lineages as 

determined by positive stain for each lineage (Figure 2 D, 
F and 8 B, D).

Protein concentration for aggregate cultures in chondrogenic 
differentiation media was comparable (0.05 ± 0.01 mg/
ml) for all three weeks (Figure 3), with a non-significant 
protein concentration decrease for the third week of culture 
(ANOVA p > 0.05). Protein within aggregates cultured in 

Figure 2. MSC identification criteria. (A) MSC morphology isolated from processed lipoaspirate. Fibroblast-like cells adhe-
rent to plastic at passage one. Scale bar 200 µm, 10X magnification. (B) Immunophenotypic profile of adipose derived MSCs. 
Cells were incubated with antibodies against human CD34, CD73, CD90 and CD105 with respective isotype control (n = 3). 
Adipogenic differentiation. (C) Representative sample of cells cultured in complete media. (D) Staining of neutral fat lipid 
droplets to confirm adipogenesis was detected by Oil Red O stain for cells cultured in media with inducers. Osteogenic diffe-
rentiation. (E) Cells cultured in complete media. (F) Extracellular calcium deposits were determined by Alizarin Red stain in 
cells cultured in complete media with inducers. Scale bar 100 µm. C – F photographs at 20X magnification.

Figure 3. Aggregate total protein quantity. Bicinchoninic acid protein (BCA) quantity 
of cell lysate reported in mg/ml for 250 x 103 cell aggregate formed at day zero by cen-
trifugation and cultured in chondrogenic differentiation media during one, two or three 
weeks. Values are the mean ± sem. ANOVA p > 0.05
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CM was not detected for all three weeks of culture. For 
all three time points (week 1, week 2, and week 3) total 
GAGs were higher for aggregates cultured in chondrogenic 
differentiation media compared to MSCs in CM (Figure 4 
A). Furthermore, DMB results normalized to total protein 
had the same trend as total GAG concentration for aggregates 
cultured in chondrogenic differentiation media (Figure 4 
B). Normalization of DMB results to total protein could 
not be performed for aggregates cultured in CM, given that 
total protein was not detected.

Since total protein values for aggregates cultured in CM 
were undetected we proceeded to analyze total GAGs 
to compare aggregates cultured in CM vs. chondrogenic 
differentiation media by microscopy histological analysis of 
Alcian blue based on two blinded observers with a grading 

system from zero (no stain) to three. Positive Alcian blue 
evidenced a significant higher grade for all aggregates 
cultured in chondrogenic differentiation media compared to 
aggregates cultured in CM for the same time points (ANOVA 
p < 0.05), suggesting chondrogenic differentiation (Figure 
5). In addition these results had a comparable trend to that 
observed for total GAGs determined by DMB, and DMB 
normalized to protein. Furthermore, Alcian blue stain based 
on percentage of positive stain determined by ImageJ analysis 
also evidenced a significant higher percentage of positive 
area for aggregates in chondrogenic differentiation media 
compared to sections from aggregates cultured in CM during 
all three time points (ANOVA p < 0.05), again confirming 
chondrogenic differentiation. The trend for total GAGs 
determined by Alcian blue percentage analyzed by ImageJ 
for aggregates cultured in chondrogenic differentiation 
media was different from that obtained by DMB and DMB 
normalized to total protein. Alcian blue percentage decreased 
with time with a gradual diminishment from 19.50 ± 1.15 
to 8.77 ±1.13. Additionally, highly significant differences 
were also observed among aggregates in chondrogenic 
differentiation media between the first and second week 
compared to the third week of culture (Figure 6).

Last, IHC evaluations using either blinded grading or 
ImageJ percentage analysis were similar for aggregates 
under chondrogenic differentiation media. For both types of 
analysis i.e blinded observer and ImageJ, a non significant 
decreasing tendency with time for aggrecan’s IHC marker 
assessment was observed. Furthermore, ImageJ IHC analysis 
had an analogous tendency compared to that of Alcian blue 
percentage also determined by ImageJ. The opposite effect 
was observed for aggregates in CM with an increase in IHC 
marker determination for both methodologies (Figure 7). 

Figure 4. Total sGAG. Biochemical composition of MSC 
aggregates on days 7, 14, and 21 of culture. Total GAG con-
tent was measured with dimethylmethylene blue method 
(DMB). (A) White bars represent aggregates cultured in 
complete media (CM). Black bars represent aggregates cul-
tured in chondrogenic differentiation media. No significant 
differences were observed between media during three weeks 
of culture (B) DMB values (mg/ml) normalized to total pro-
tein (mg/ml) for aggregates cultured in chondrogenic diffe-
rentiation media. One way ANOVA p > 0.05.

Figure 5. Alcian blue blinded observer score. Cells cultu-
red in aggregates in CM (white bars) or chondrogenic diffe-
rentiation media (black bars) during first, second and third 
week of culture. Stain was qualified based on a grading 
system from zero to three (0 = no stain). One way ANOVA 
* p < 0.05, ** p < 0.01, *** p < 0.001.
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When comparing aggrecan’s IHC results between blinded 
observer grade and ImageJ percentage a starker contrast 
between CM and chondrogenic differentiation media was 
observed for the ImageJ analysis. No significant differences 
were observed for blinded observer or ImageJ analysis.

Discussion
We developed a functional system for semi-automatic slide 
grading for MSCs in vitro chondrogenic differentiation using 
ImageJ, a public domain, Java-based image processing 
program developed by the National Institutes of Health 
in 1997 (20). This open-source software permits cutting-
edge image processing and can be used as an indispensible 
support for researchers in different fields. To our knowledge 
this methodology innovates in the way histological slides 
are evaluated for in vitro chondrogenic determination. We 
corroborated image analysis results by biochemical analysis 
with comparable results. For histochemical procedures color 
segmentation was applied, with color filter values selected 
by the evaluator. Furthermore, we developed a novel IHC 
quantification technique not relying on color segmentation 
based on RGB intensities, but rather on hue saturation and 
brightness (HSB). Consequently, this procedure could be 
used for other applications in the biological and medical 
fields depending on the user’s need. 

Chondrogenesis was activated by a commercial available 
media supplemented with IGF-1, insulin, transferrin, TGF-β1 
TGF-β3 and BMP-6, all are known chondrogenic inducers 
(21-23). Chondrogenic differentiation was confirmed by 
Alcian blue stain by blinded observer evaluation and ImageJ 
percentage determination. Spheroids cultured for three 
weeks in CM had a lower grade (blinded observer) or lower 
percentage (ImageJ) compared to aggregates in chondrogenic 
differentiation media. Thus, confirming that inducers had 
an effect on total GAG synthesis during aggregate culture, 
and suggest cells in chondrogenic differentiation media were 
undergoing chondrogenic differentiation process. 

For Alcian blue stains in aggregates cultured in complete 
or chondrogenic differentiation media we calculated 
the percentage difference in standard error mean (sem) 
between ImageJ and conventional blinded observer 
methodology (Table 1). Results obtained using ImageJ 
software demonstrated a greater than 50% improvement 
in relation to conventional blinded observer methodology. 
These results suggest that error can be substantially reduced 
when using a more objective methodology for image 
analysis and scoring.

Our results obtained by histological analysis were supported 
by biochemical assays that proved aggregates cultured in 
chondrogenic differentiation media had a higher GAG 
concentration in their ECM compared to those cultured in 
CM. These results agree with those previously reported 
in the literature (17). Furthermore, DMB results for CM 
could not be normalized to total protein, because of 
undetectable protein values. These results evidence the 

Figure 6. Alcian blue positive stain percentage using 
ImageJ. Cells cultured in aggregates in CM (white bars) or 
chondrogenic differentiation media (black bars) during first, 
second and third week of culture. Percentage was determined 
as described in detail in Materials and Methods section. One 
way ANOVA ** p < 0.01, *** p < 0.001.

Figure 7. Aggrecan IHC score. IHC aggrecan marker in 
MSCs cultured in complete (white bars) or chondrogenic dif-
ferentiation media (black bars) during three week aggregate 
culture. (A) Blinded observer grade. One way ANOVA p > 
0.05. (B) ImageJ percentage. One way ANOVA * p < 0.05.
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limitations of biochemical assays for very small samples. 
Since chondrogenic differentiation characteristics based on 
biochemical criteria presented an obstacle (undetectable 
protein for aggregates in CM) we developed this semi-
automatic functional system using ImageJ to perform a 
more objective and accurate assessment of histochemical 
stains and IHC marker to determine in vitro chondrogenesis.

For biochemical assays we used DMB method as described 
by Farndale with modifications (24). This highly sensitive 
technique permitted to assay total GAGs concentration 
from 5 µg/ml to 50 µg/ml from a sample with low protein 
quantities, as those obtained in this work from a lysed 
aggregate with a range of protein content from 0.03 ± 0.01 
mg/ml to 0.060 ± 0.01 mg/ml. We observed total protein did 
not have a significant change throughout the chondrogenic 
process. This suggests cellularity remained similar during the 
three weeks when aggregates were cultured in chondrogenic 
differentiation media. 

Moreover, we normalized total GAGs to total protein. Using 
total protein to normalize total GAGs provides advantages 
such as cost reduction and a less cumbersome methodology 
compared to other parameters such as total DNA (9, 25). 
On the other hand, this technique is not sensitive enough 
to quantify very low protein values. This could explain 
why we were unable to detect protein for CM, and could 
not normalize DMB results for aggregates cultured in CM. 

For aggrecan’s IHC we observed ImageJ methodology had a 
better performance for aggregates cultured in chondrogenic 

media compared to MSCs cultured in CM (Table 2). 
Again, as for the Alcian blue stain this technique presents 
greater advantages as compared to conventional grading 
methodologies. 

Table 2. Aggrecan IHC Percentage Improvement.

Aggregates cultured in complete or chondrogenic 
differentiation media were assayed at days 7, 14 or 21 for 
either media. Improvement analysis referred to as percentage 
improvement was calculated as described in the materials 
and methods section. IJ: ImageJ. BO: Blinded observer.

Aggrecan IHC

Media
Time of 
culture  
(days)

IJ vs. BO percentage 
improvement

Complete 
media

7 43.39 %
14 No improvement
21 No improvement

Chondrogenic 
Differentiation 

media

7 No improvement
14 18.31 %
21 70.50 %

Even though the objective of this study was to establish a 
semi-automatic grading system;  contrasting results between 
total GAGs and aggrecan detection by IHC are important 
for their biological implications. Aggrecan is composed 
of two types of GAGs, a small keratan sulfate domain and 
a larger chondroitin sulfate domain (26). We observed a 
gradual aggrecan decrease with time for aggregates cultured 
in chondrogenic differentiation media in contrast to GAG/
protein biochemical analysis with an increase for the last 
week of culture. Aggrecan is not the only GAG synthesized 
during chondrogenesis (27). Other GAGs, such as heparan 
sulfate, dermatan sulfate and syndecan, could be involved in 
the process, probably explaining these contrasting results. 

During the earlier stages of chondrogenesis mesenchymal 
cells differentiate into chondrocytes and begin to synthesize 
collagen type 2 and aggrecan. This event sets the stage for 
mesenchymal cell differentiation into chondrogenesis (28). In 
a report of human adipose MSCs undergoing chondrogenic 
differentiation aggrecan expression was restricted to early 
events, days seven and ten, and was specific to aggregates 
under chondrogenic induction (17). Other studies with human 
adipose derived MSCs also have demonstrated aggrecan’s 
expression after seven days of culture in chodrogenic 
differentiation media (11, 22). Aggrecan synthesis initiates 
during chondroprogenitor proliferation and differentiation 
and its synthesis stops with terminal differentiation (1). Thus, 

Table 1. Alcian blue Percentage Improvement.

Aggregates cultured in complete or chondrogenic 
differentiation media were assayed at days 7, 14 or 21 for 
either media. Improvement analysis referred to as percentage 
improvement was calculated as described in materials and 
methods section. IJ: ImageJ. BO: Blinded observer. N.D. 
Not determined. 

Alcian blue 

Media
Time of 
culture  
(days)

IJ vs. BO 
percentage 

improvement

Complete 
media

7 N.D
14 53.38%
21 79.34%

Chondrogenic 
Differentiation 

media

7 56.87%
14 68.25%
21 39.52%
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our blinded observer and ImageJ percentage analysis results 
for aggregates cultured in chondrogenic media agree with 
reports in the literature regarding aggrecan’s expression. 
These results demonstrate the biological importance of 
computer assisted quantification of histological results during 
in vitro chondrogenesis that corroborate with biochemical 
and immunological attributes to determine differentiation.

For histological analysis images were captured by 
conventional microscopy. This technique permitted to obtain 
for most slides the entire section at 20X magnification 
with low resolution. At higher magnification (40X) images 
have higher resolution, but the section cannot be captured 
completely. In order to provide a solution we used robotic 
microscopy. We compared at random captured images 
from conventional microscopy and robotic microscopy and 
observed an improvement with the latter. A comparison 
between both microscopy capture methodologies for Alcian 
blue stain is depicted in Figure 8. On panel A, B, and C 
we observe images captured by robotics microscopy. As 
can be seen, robotics captured images appear as if part 
of the background were missing. This is the result of the 
assembling process, since each section is captured, according 

to the algorithm designed, and the assembled image does 
not guarantee an image with a homogenous background. 
The robotics image capture provides the researcher several 
advantages over images captured with a conventional 
microscope. For one, it allowed greater detail, since the 
complete section can be integrated as one image. In contrast, 
conventional microscopy, as that observed by panel D 
does not permit this type of detail. In order to capture the 
entire aggregate section the objective must be at 20X. For 
larger slide sections using conventional microscopy capture 
techniques, for example those a pathologist might encounter, 
integration of images would have to be carried out manually. 
Collectively, robotics microscopy improves detail, because 
it integrates the complete section at 40X magnification with 
aid of an algorithm developed by BioIngenium engineers. 
This complete image can then be analyzed by ImageJ. 

Panels C and D in figure 8 demonstrate ImageJ analysis 
percentage determination. The area that was positive for 
Alcian blue stain is highlighted in red. This is more easily 
observed for panel D, where the aggregate was cultured 
in chondrogenic differentiation media. This methodology 
permits more objectivity compared to blinded observer 

Figure 8. Alcian blue stain analysis using ImageJ. Aggregates cultured in complete (A and C) or chondrogenic differentia-
tion media (B and D) for 14 days. (A) Aggregate section of representative sample during two weeks of culture in complete 
media. Digitally photographed at high resolution (40X) by automated system. Captures were assembled into one image by 
algorithm designed by BioIngenium. Scale bar 100 µm. (B). Representative sample of aggregate cultured in chondrogenic dif-
ferentiation media. (C) Color segmentation to determine threshold values for capture in A. (D) Color segmentation to determine 
threshold values for capture in B. 
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evaluation, because the observer by using ImageJ can 
quantify in a semi-automatic manner the slide section and 
give a percentage of positive stain or IHC chondrogenic 
marker to determine differentiation.    

Although techniques for quantifying histological stains have 
been reported (18, 19, 29), recent development in automated 
image analysis describe the use of sophisticated digital 
capture of histological slides. This type of equipment cost can 
range from $ 100,000 to $ 300,000 US dollars. Furthermore, 
IHC analysis requires use of DAB deconvolution to digitally 
separate different stains, and some researchers describe using 
methods implementing ImageJ macro (18). Other image 
processing programs offer an image processing toolbox that 
can be used for color space conversion and image filtering, 
such as MATLAB, yet this software must be purchased. 
In this report we present an option for capturing images 
at high resolution and analyzing them using free software.        

Conclusion
We developed a functional system for semi-automatic slide 
grading, and corroborated these results by biochemical 
analysis with comparable results for in vitro chondrogenesis. 
This computer assisted quantification provided a percentage 
improvement compared to blinded observer methodology. 
To our knowledge this is the first report to evaluate stains 
using this methodology providing a quantifiable and 
impartial technique to assess in vitro differentiation.  In 
addition, automated image analysis enables improved 
detail and accuracy for slide assessment. This methodology 
represents an advantage for the researcher analyzing and 
scoring slide sections. Overall, these findings suggest that 
semi-automatic grading system using ImageJ is a more 
objective way to analyze microscopy images and can be 
applied to other fields. 
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